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Welcome
Welcome to iView MediaPro, the fast and easy 
way to view, organize and present the growing 
number of images, movies, sounds, fonts and 
other media files on your disks.

MediaPro helps you get organized. Whether 
you are a student, journalist, multimedia enthu-
siast or creative professional, it’s important to be 
able to organize and browse your images, movies, 
documents and other files in an application that’s 
easy to set up and use.

MediaPro works by creating catalogs, consist-
ing of thumbnails and descriptions of all your 
media files. Store your images with digital cam-
era information, captions, labels and annotations  
—  then search and browse the catalog, even if 
your original files are misplaced or offline. 

You can batch process your media files, includ-
ing renaming, image editing, manage color pro-
files, print contact sheets, change file formats and 
create slide shows.

Installation 
Windows: When you insert the iView MediaPro 

CD, an install menu appears. Choose Install iView 
MediaPro and follow the instructions. 

If this menu does not appear, your PC may not 
support autostart. In this case, open the CD and run 
install_iview_mediapro.exe. 

Mac: Insert the iView MediaPro CD. Double-click 
on the Install MediaPro 3 icon and follow the instruc-
tions. If you have an existing copy of MediaPro, 
remove it from your Applications folder and rename 
the folder or place it on removable media volume 
before installing the new version. 

Entering your license key 
After you have installed iView MediaPro, launch 
the application. Go to the License menu and enter 
your name, organization and the license number 
from the inside back cover of the manual.  

If you purchased a digital download version 

Installing and setting up iView MediaPro
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Installation 

Step 1: Windows CD - This menu appears when you 
insert the iView MediaPro CD.  Choose Install iView 
MediaPro. If this menu does not appear your PC may not 
support autostart. In this case, open the CD and run the 
installer program named install_iview_mediapro.exe. This 
will create an application shortcut icon and a shortcut 
to the iView web site on the desktop.

Step 2: If you did not enter your license during the 
installation wizard, then launch MediaPro and go to the 
License menu and select Enter License.

Step 3: Enter the license number from the inside back 
cover of the manual, or the one that was emailed to you.

Step 1: Mac CD - Insert the iView MediaPro CD. 
Double-click on the Install MediaPro 3 icon. Follow the 
instructions.
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of iView MediaPro online, then enter the license 
number that was emailed to you. If you have lost 
your license key, please contact support at: 
http://www.iview-multimedia.com/support/

Plug-ins
The installation will create a Plug-ins folder con-
taining files that are important to the application’s 
functionality.  Knowing the location of this folder 
is important so that you can customize or install 
additional functionality, such as HTML themes, 
print templates, importers and scripts.

Windows: The user-defined Plug-ins folder is 
located in one of two locations:

• C:\Documents and Settings\username\Appli-
cation Data\iView\Plug-ins

• C:\Documents and Settings\All Users\Appli-
cation Data\iView\Plug-ins
On some Windows operating systems the 

Application Data folder may be hidden. 
To display hidden folders on Windows XP:

1. Click Start, and then click Control Panel.
2. Click Appearance and Themes, and then click 

Folder Options.
3. On the View tab, under Hidden files and folders, 

click Show hidden files and folders. 
Hidden files and folders will appear dimmed to 

indicate they are not typical items. If you know the 
name of a hidden file or folder, you can search for it. 

When installing custom HTML themes, print 
templates, vocabularies, scripts or importers, place 
them inside the user-defined plug-ins folder, and 
not the application Plug-ins folder. This way, you 
will not lose your custom settings when upgrad-
ing to future versions of MediaPro.

Mac: In previous versions, there was a Plug-ins 
folder inside the MediaPro application folder. This 
folder has now been split between built-in plug-
ins, which are located inside the application pack-
age, and user-installed plug-ins, which can be in 
any of the three locations

• ~User/Library/Application Support/iView/
Plug-ins

• /Library/Application Support/iView/Plug-ins

• Network/Library/Application Support/iView/
Plug-ins
When installing custom HTML themes, print 

templates, vocabularies, scripts or importers, place 
them inside the user-defined Plug-ins folder, and 
not the application package. This way, you will 
not lose your custom settings when upgrading 
to future versions of MediaPro.

System requirements 
This section lists the minimum system require-
ments, with the recommended ones in parenthe-
ses. It is important to have the most recent version 
of QuickTime. This will improve iView MediaPro’s 
performance and functionality.

Windows
• Pentium III 500 MHz processor or equivalent  
(Pentium 4)

• 128 MB of RAM (256 MB)
• 1024 x 768 display with 16-bit color
• 20 MB of hard disk space for installation  
(200 MB of free disk space ideal)

• Windows XP (XP SP2)
• QuickTime 6.4 or higher
• Internet Explorer 5.5 (6.x)
• DirectX 9.0 for Windows Media format support
• Adobe Reader 7.0 for PDF file support

Macintosh
• PowerPC or newer, such as iMac G3, G4; 
MediaPro supports Intel-based Macs.

• Mac OS X (10.3.9)
• QuickTime 6.4 (7.x)
• Monitor set to Millions of Colors
• 13 MB of hard disk space for installation

Language support
MediaPro can be viewed in: English (US),  French, 
German, Italian and Japanese. By default, MediaPro 
uses the language of the operating system or 
remembers the last language used. See figures 
on the next page for information about how to 
change the language used by iView MediaPro.

In
stallation
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Web resources
You can access additional resources for learning 
iView MediaPro on the iView web site. Tutori-
als, customer support, forums and application 
updates are available online. To go to the web 
site at: www.iview-multimedia.com

Software updates
Windows: You can check for updates to iView 
MediaPro by selecting Check for Updates in the 
Help menu. If an update is available, a link will be 
provided for you to download it. Mac: Check for 
Updates is located in iView MediaPro application 
menu › About iView MediaPro dialog.

Adding media importers 
Any QuickTime-based media importer can be 
used by MediaPro: simply download and install 
the importer. Additional importers can be down-
loaded from 3rd-party sources on the Internet.

Example: To catalog Windows Media files (.wma, 
.wmv) on Macs, download and install the Flip4Mac 
QuickTime plug-in at: http://www.flip4mac.com/

Scripting 
MediaPro is scriptable and can be easily integrated 
with 3rd-party applications or database systems to 
perform workflow automation. 

Windows: MediaPro supports Visual Basic Script 
and JavaScript automation on Windows. Once you 
create scripts, you can attach them to the appli-
cation for access through the Scripts menu. For 
instructions on creating scripts, refer to the script-
ing documentation included with iView (see Docu-
mentation folder).

Mac: MediaPro supports AppleScript, and the 
scripts are attachable to the application (acces-
sible via the AppleScript menu). To get started 
with scripting MediaPro, look at the application’s 
dictionary, and refer to the AppleScript examples 
included (see Documentation folder). Test your 
existing scripts to ensure proper functionality 
before using them. For additional information on 
scripting with MediaPro, see page 121.
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Mac OS X:  To change languages, select the MediaPro 
icon and choose Get Info from the File menu. Choose 
Languages in the drop-down menu. MediaPro will default 
to the operating system language. If you want MediaPro 
to run in a different language, uncheck all languages 
except the one you want. 

Windows:  Choosing MediaPro’s language is the first 
step in the installation process on Windows. To changes 
languages, install MediaPro again, while selecting an 
alternate language from this drop-down menu.
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How MediaPro works
MediaPro stores information about your media 
files in catalogs. A catalog is a searchable and 
organizable visual database that contains: 

• Information about each file relevant to the 
media type (attributes).

• Tags (also called annotations or metadata) 
that help you organize and classify media.

iView MediaPro basics

• A thumbnail of each media file.
• A full screen preview of each media file (if this 
option is turned on).

• The location (path) of the original file on a 
hard drive, CD-ROM, or other kind of volume.
You can create as many catalogs as you want, it 

just depends on how you want to organize your 
media. For example, you can have a catalog for 

M
ed

iaPro Basics

iView MediaPro Catalog

IMPORT

Camera Media Card Folders/Discs

JPEG

• File properties
• EXIF digital camera metadata
• IPTC/XMP metadata
• QuickTime metadata
• A voice (audio) annotation
• Custom (user-defined) metadata
• ICC color profile; color sample
• Color label; Star rating 

METADATA

Each item will be assigned either:
• An embedded thumbnail created by 

a digital camera or software program
• A thumbnail created by MediaPro
• A generic media icon

THUMBNAILS

If this option is turned on, MediaPro 
will create and store a large JPEG 
image that canbe displayed in Media 
View, Slide Shows and Light Table.

FULL SCREEN MEDIA PREVIEW

The location of the original file on a 
local or removable storage media.

PATH

Synchronize: For each file, the metadata information can be 
edited in the MediaPro catalog. To export these changes and 
write the information back into the file, use the Sync Annotations
command in the Action menu.

What’s inside each
iView MediaPro catalog

A catalog does not store the 
actual media files. When each 
media item is imported into a 
catalog, MediaPro extracts and 
stores information about the 
file (shown at right).
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Catalogs stored hierarchically by subject, date and 
project. The catalogs are stored in proximity to 
the media files.

0205_Job315_FordF150_Catalog.ivc
0205_Job316_MazdaMX5_Catalog.ivc
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2005 Car Photography
•Car_Photo_Portfolio.ivc

•2005_Stock_Media.ivc
•PDF_Car_Photo_Research.ivc
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Job316_MazdaMX5_ToPrint.ivc

Job316_MazdaMX5_Raw.ivc

050205_Mazda_Job316_03.CR2
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Date ProjectSubject

0205_Job315_FordF150_Catalog.ivc
0205_Job316_MazdaMX5_Catalog.ivc

0205_Job314_ChevyTahoe_Catalog.ivc
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0105_Job312_EW_JStewart_Catalog.ivc
0105_Job311_CBS_Fall_Catalog.ivc
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0105_Jan_Catalog.ivc
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2005 Car Photography
•Car_Photo_Portfolio.ivc

•2005_Stock_Media.ivc
•PDF_Car_Photo_Research.ivc
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0205_Job315_FordF150
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050205_Mazda_Job316_01.CR2
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Example A

Example B
File Type Process

Catalogs organized by file type and process in the 
workflow. Process catalogs work particularly well 
for workgroup workflow.

each media type: photos, videos and music. Or 
you could create one catalog of all your media. 
Each catalog can contain up to 128,000 files.

Understanding catalogs
When you add files to a catalog, MediaPro stores 
a thumbnail of each file, as well as information 
about the file and its location on your disk. 

This way you can search and organize iView 
MediaPro catalogs, even when your original files 
are not present. For example, they may be stored 
on a CD-ROM that is not in the computer. But you 
can still view thumbnails of those files and infor-
mation about the media in the catalog. 

Because media files are not embedded in the 
catalog, iView MediaPro will need access to media 
files in order to display them in larger sizes, such 
as Media View, Light Table and Slide Shows.

If you delete a media file on the desktop or a 
disk, it cannot be recovered through a MediaPro 
catalog. A catalog only contains information 
about the file, not the file itself.

Adding files to an iView MediaPro catalog does 
not move or modify the original media.

MediaPro 3 Catalog Icon 
on the Desktop

Cataloging strategies
A common question in digital asset management 
is: “Should I put all my media into one big catalog; 
or into several smaller catalogs?”

The number of catalogs that you create will 
vary depending upon your workflow and the 
types of media being tracked in catalogs.

iView MediaPro catalogs are designed to con-
tain up to 128,000 media items. It is possible that 
a single catalog will be sufficient for your needs. 
That being said, grouping files into separate cata-
logs creates a higher level of organization, and can 
help you have a higher degree of success quickly 
finding the appropriate media.

There are many strategies for grouping items in 
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catalogs, but anything that is logical and fits well 
into your specific workflow needs is acceptable.  
Here are some ways to organize your catalogs:

By Project: In Example A (previous page), each 
assignment has a dedicated catalog. This will facil-
itate easily working with files dedicated to a client 
or project. It also is good method for supporting 
short-term deadlines and goals.

Chronology: Creating an additional set of 
date-based catalogs is a good monthly habit. It 
will help you build a searchable archive as you go, 
instead of doing it all at once. 

Annual and monthly chronological catalogs 
are simple to create using MediaPro’s Import Items 
From Catalog File function (File menu). Simply cre-
ate a catalog for a particular time frame (month) 
and import each job or project catalog from that 
time frame. This ensures that all metadata, groups, 
sets and user-defined fields are imported into the 
new date catalog. 

By Subject: Any logical subjects that aren’t 
likely to overlap are a good way to divide your 
media into multiple catalogs.

For example, you may store your images by 
high-level subjects that describe the types of your 
photo assignments: travel, fashion, portraits, etc.

Alternatively, each time you create a catalog, 
you might mark files that you think should be-
long in a “Best Of” collection. Creating a catalog 
dedicated to building a portfolio or best media 
of the year is a good practice as well.

By Process/Task: Sometimes there are clearly 
definable states for files in a workflow. Separating 
items by their state or task in your workflow can 
help direct users to the media item at the correct 
stage in the workflow. 

For example, if photographers want to track 
files through a raw workflow, they might create 
catalogs for the original raw files, client selections, 
processed TIFFs, color corrected images and those 
that have been touched up (see Example B on pre-
vious page).

By File Type: You may wish to group files into 
catalogs based on file type, such a music, movies, 

Project catalogs are named chronologically 
to maintain proper order on the desktop and 
are stored in a single folder for cross-catalog 
searchability.
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Search this catalog or 
this folder of catalogs

Example C

fonts, illustrations or PDFs.
For example, you may want to create a catalog 

of all your fonts, creating a searchable inventory 
of typefaces available for your design projects.

Searchability: MediaPro has a special search 
criteria that enables searching across all catalogs 
in a particular folder (Find menu).

Thus, if you store all your job catalogs in a de-
fined folder (see Example C above), files will be easy 
to locate. Higher level chronological catalogs will 
also be good for locating media files.
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4. Choose the size of previews to be created 
(Options: 800, 1024 and 1280 pixels).

5. Choose the JPEG compression quality to be 
applied to the preview images.

6. Click the OK button. Import your media items 
and save your catalog.
Please be aware that the file size of catalogs 

with full screen previews will be considerably 
larger than catalogs with only thumbnails. 

Filter imports by media type
Import options control what media files are added 
to a catalog. Most import options are conditional 
to the type of import (From Folders, Camera, etc.)

However, there is a global option to limit import-
ing just those files that belong to a certain media 
type. To define a media type filter, select Catalog 
Importers in the File menu. Check the box for each 
media group you want to allow MediaPro to import 
or ignore in future catalogs.

For example, when Importing from Files/Folders, 
you might turn on only the Images option in order 
to import images such as JPEG, TIFFs, etc. and skip 
all other files in the same folder.

If you are not familiar with what types of media 
files belong to each group, you can check the box 
for a particular media group to see a comprehen-
sive list of all media types supported. 

• A thumbnail created by MediaPro:  Turning 
Use built-in thumbnails option off will instruct 
MediaPro to create new thumbnails, which 
are generally higher in quality, at the cost of a 
slower import process. For the highest quality 
thumbnails, iView recommends this option.

• A generic media icon: Some non-image files, 
such as audio files, will have a generic media 
icon assigned as a thumbnail.

Define thumbnail size
Before creating a catalog, you need to define how 
MediaPro creates thumbnails: at a fixed size or at 
a variable size that matches the active display size 
set in Thumbnail View.
1. Create a new catalog.
2. In the Edit menu, select the Thumbnails &  

Previews option.
3. Choose the size of thumbnails to be created 

(Options: 160, 320, 480, 640 pixels). If you 
choose Variable size, MediaPro create thumb-
nails matching the thumbnail size defined in 
the Thumbnail View of the active catalog.

4. Choose the JPEG compression quality to be 
applied to the thumbnails.

5. Click the OK button. Import your media items 
and save your catalog.

Media previews
These previews are large JPEG proxy images that 
will be displayed in Media View, Slide Show and 
Light Table regardless of whether or not original 
media files are available for display. 

Media previews are particularly useful if the 
majority of your media is stored on offline stor-
age volumes, such as CD or DVD.  These previews 
are also useful for distributing catalogs without 
having to include the original media files. 

To create a catalog with media previews:
1. Create a new catalog.
2. In the Edit menu, select Thumbnails & Previews.
3. Check the Create full screen previews box. This 

will enable the creation of Media Previews.
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Catalog Importers: Use to filter media types on import. 
Press the Set as Default button to set the media types 
filter for future catalog imports.
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there is a shareware utility that can assist you, XRay.  
Drag-and-drop the file on the to the XRay window 
as directed by the application. Under the Show pull-
down menu, select Type, Creator and Extension. This 
will display the file type information.

Import items from Files/Folders
1. Open your catalog  or create a new one. 
2. Choose a file or folder: Select Import Items 

from Files/Folders in the File menu. Navigate 
to and select a file, group of files or a folder of 
media to import into your catalog. Files and 
folders can be located anywhere: on your hard 
drive, media cards, removable storage media 
or a local area network hard drive.

3. Define Import Criteria:  These filters limit the 
range of imported media based on file-related 
criteria, such as filename, file size, or the date 
last used. For example, to only import files 
smaller than 1 MB, choose to enable the Size 
option as:  “Size is less than 1 MB.” Checking 
the Flat folder search option will constrain 
folder imports to only the folder level selected 
and ignore all sub-folders.

4. Import: Click the Choose button and MediaPro 
will import all files and folders selected.

Supported file formats
MediaPro can catalog more than 100  media file for-
mats. MediaPro’s capacity to import certain file types 
is dependent on having the most current version 
of Apple’s QuickTime installed on your computer. 
QuickTime can be downloaded for free online at:
http://www.apple.com/quicktime/

There are variations of file format support be-
tween the Windows and Mac platforms. For a com-
plete list of supported formats, see page 145.

Cataloging unsupported formats 
MediaPro allows you to add basic cataloging 
support for other media file types by modifying 
the Custom importer list. Thumbnail and media 
rendering of these files is not supported. Instead, 
these files will be represented by a generic icon 
corresponding to the file type group.

Video DTP Image

To add a file type to the Custom importer list
1. Locate the user-defined Plug-ins › Importers 

folder. Open the Custom file with a text editor.
2. Add your custom formats to the list. For ex-

ample, to add FileMaker file support, write: 
FMP3|6|FileMaker Pro 
The first four characters are the file type. The 
next is the Media ID, which are listed at the 
top of the list. If you choose the wrong ID, 
MediaPro will not catalog the file. The remain-
ing segment is the name of the program.  You 
must follow the exact format in order for the 
new file importer to work properly.

3. Save the text file and launch MediaPro.

Finding file types
On Windows, the file type is always the same as 
the file extension, with spaces appended to make 
up four characters. 

On the Mac, finding the file type is more com-
plicated. In Mac OS X, there is no utility in the oper-
ating system that can identify file types. However, 
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Import Items from Files/Folders
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Import items via drag-and-drop
You can drag-and-drop any file, folder, hard disk, 
CD, or volume onto an open MediaPro catalog 
to add media. You can also drop files onto the 
MediaPro icon or shortcut icon. In either case, 
your media files will appear in a catalog.

You can also drag-and-drop a folder that con-
tains some files already cataloged and a few new 
files. MediaPro will skip files already cataloged and 
add only the new files to the catalog. 

Import items from 
Pictures/Movies folders
In the Getting Started dialog, check Import Pic-
tures/Movies Folders. MediaPro will automatically 
find the Pictures and Movies folders for the active 
operating system user and import all media into 
a new catalog. 

MediaPro will ignore media in folders dedicat-
ed to certain applications such as Apple’s iPhoto.  
This importing feature only works on the Mac OS X 
and Windows XP operating systems.

Import items from Spotlight Query
MediaPro can now import items from your com-
puter using Mac OS X’s advanced search technol-
ogy called Spotlight. 

When you search via Spotlight, you’re accessing 
a comprehensive, constantly updated index that 
sees all the metadata inside supported files on 
your hard drive, including the kind of content, the 
author, edit history, format, size and much more. 

Most documents, including Microsoft Word 

documents, Adobe PDF documents, MP3 audio 
files and digital camera images, already contain 
rich metadata. And because Spotlight indexes 
contents of the file as well, your search results 
include what appears inside a file or document, 
not just its title.

To use this function, choose Import Items from 
Spotlight Query. Type a word or phrase to search for 
and MediaPro will import all related media files. You 
can also type a Spotlight Query, using special Spot-
light syntax, to specify complex search criteria.

By default, Spotlight imports are appended 
to the open catalog. Checking the Add results in 
new catalog will place all imported items in a new 
catalog.

Import items from desktop 
contextual menu
The MediaPro Contextual Menu plug-in is a sys-
tem level plug-in that allows you to add items to 
a MediaPro catalog simply by selecting a menu 
item directly from the computer’s desktop. Simply 
right-click (Mac: Ctrl-click) on a file or folder and 
select iView MediaPro Import from the contextual 
menu. Items will be added to the open catalog or 
a new catalog, if one is not currently open.

This plug-in is automatically installed with the 
application.
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Add files through drag-and-drop: Files are added to a 
catalog in the exact position of the cursor highlight, the 
long bar that is separating the two items above.

Import from Spotlight Query



14    IV IE W MEDIAPRO USER MANUAL

Import items from iPhoto
Mac: In the Getting Started dialog, check Import 
iPhoto Library. MediaPro will automatically find 
the iPhoto library for the active operating system 
user, launch iPhoto in the background and import 
all original photos into a new catalog. This feature 
only works with versions 2, 4, 5 and 6 of iPhoto.

The new catalog contains references to your 
photo files that are still inside the iPhoto library 
folders.  If you wish to move these files out of the 
iPhoto library, you can select all the images in the 
catalog and select Transfer to Folder in the Action 
menu. Choose Move files, reset paths, delete originals. 
This will move your original images to a folder of 
your choice, sets the paths to the new location and 
delete the images from your iPhoto library. 

To free up additional hard drive space, you could 
delete all the proxy images (thumbnails) created 
by iPhoto. To do this, simply trash the iPhoto Library 
folder from the Pictures folder. Make sure you do 
this after you have transferred all original images 
to a new location on your hard drive. Or you could 
leave the original images where they are and have 
media in both iPhoto and iView MediaPro.

The new MediaPro catalog will also contains your 
iPhoto albums as MediaPro Catalog Sets (in the Orga-
nize Panel). Your catalog also contains any metadata 
(such as EXIF digital camera data, comments or key-
words) that were assigned to your images in iPhoto. 
The chart above details how iPhoto annotations 
map to iView MediaPro annotation fields.

Import from Adobe Photoshop 
Album and Photoshop Elements
Windows: In the Scripts › Import menu,  there 
are three scripts that will import the media from 
Adobe Photoshop Elements or Photoshop Album 
catalogs into a iView MediaPro catalog.

The first script Import from a Photoshop Album-
Elements catalog file will import media items from 
any Photoshop Elements or Photoshop Album 
catalog with the file extension .PSA. Album and Ele-
ments allow the creation of multiple catalogs. You 
can use this script to import a catalog that is not 

actively being used by Adobe Photoshop Album 
or Elements. To use this script:
1. Create a catalog or open an existing catalog.
2. Select From a Photoshop Album-Elements cata-

log file in the Scripts › Import menu. 
3. Navigate to and select your Album/Elements 

catalog that you want to import.
The other two scripts, Import from the active 

Adobe Photoshop Album catalog and Import from 
the active Adobe Photoshop Elements catalog, will 
automatically import the active catalog being used 
by either program. To use these scripts:
1. Create a catalog or open an existing catalog.
2. Select From the active Photoshop Album catalog 

or From the active Photoshop Elements catalog 
in the Scripts › Import menu. 

3. MediaPro will automatically find the Album 
or Elements catalog for the active user, and 
import all images into a MediaPro catalog. In 
the rare case that MediaPro cannot find the 
catalog, it will ask you to locate it. Typically, 
catalogs are stored at:

 • C:\Documents and Settings\All Users\Applica-
tion Data\Adobe\Catalogs\

M
ed

ia
Pr

o 
Ba

si
cs

Annotation mapping for iPhoto import

Annotation mapping for Adobe Photoshop Album or 
Photoshop Elements import

* iPhoto 4, 5

iPhoto MediaPro

Filename Filename

Title Title

Keyword Keyword

Checkmark (keyword) Does not map at this time

Star Ratings* Do not map at this time

Albums Catalog Sets

Smart Albums* Catalog Sets 

Comments	 Description (Caption)

Date Event Date

Date (modified in iPhoto) Event Date

Album/Elements MediaPro

Caption Description (Caption)

Tags Do not map at this time
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dropped files are added at the specific position 
in the catalog defined by your cursor placement 
(applies to List and Thumbnail Views). 

If you drag-and-drop items into a catalog that is 
currently in Media View, then the dropped items 
will appear at the end of the catalog.

Using drag-and-drop does not remove a file 
from a catalog and add it to another. This function 
copies a media item’s reference from one catalog 
to another. As such, each item’s related annota-
tions, label and thumbnail are added. 

If you hold down the Ctrl key (Mac: Cmd key) 
while dragging-and-dropping, MediaPro will re-
move a file from a catalog and add it to another.

If the open catalog already contains files that 
are part of the selection of files that are being 
dragged-and-dropped, MediaPro will ignore 
these files and will not replicate them.

Matching thumbnail size when merging
If the item’s thumbnail in an older catalog is 
smaller than the catalog being appended, then 
the thumbnail will have to be rebuilt to match the 
new size. 

For example, an older catalog might have 128 
pixels thumbnails. The new catalog it is being 
merged into has 320 pixel thumbnails, then the 
previous thumbnails will appear smaller. To fix 
this, select the appended files and choose Rebuild 
Item in the Action menu.

On some Windows operating systems the Ap-
plication Data folder may be hidden. See page 5 
for instructions on showing hidden folders.

These import scripts work with Photoshop 
Album 1, 2 and 3 and Photoshop Elements 4.

Your new MediaPro catalog will contain metadata 
such as EXIF digital camera data and Descriptions 
that were assigned to your images in Album or Ele-
ments. Any tags, keywords or additional metadata 
will not be imported.

Import from catalog file
iView MediaPro can combine the contents of one 
catalog with the contents of another.  The Import 
Items From Catalog File command (File menu) ap-
pends a selected catalog to the currently open 
catalog. 

How to merge catalogs
1. Open an existing catalog.
2. Choose Import Items From Catalog File from 

the File menu.
3. Navigate to and select a catalog created by 

an iView product (including previous versions 
of MediaPro, or iView Media or MediaLE).  This 
function will not work with catalogs created 
by other programs.

4. New media items will be appended to the 
end of the existing catalog. Each item’s related 
annotations, label and thumbnail are added 
as well. Catalog Sets are now merged into the 
open catalog.
If the open catalog already contains files that 

are part of the selection of files that are being 
merged, MediaPro will ignore these files and will 
not replicate them.

Merging catalogs using drag-and-drop
An alternative way to add items from one catalog 
to another is using the drag-and-drop method. 

To do this, open two catalogs. Select one ore 
more items, and drag them from one catalog to 
the other. Unlike Import From Catalog File, where 
files are appended to the bottom of the catalog, 
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Import from Catalog File: Navigate to and choose an 
iView MediaPro catalog file on the desktop.
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Import from a digital camera 
Windows XP instructions
Depending on the USB transfer settings of your 
camera, there are two ways to import images from 
digital cameras. 

Some digital cameras support a standard called 
Picture Transfer Protocol (PTP). Refer to your digital 
camera’s documentation to find out if it supports 
PTP and how to properly define PTP settings for 
the camera. 

A. Using Picture Transfer Protocol
If your camera supports PTP: 
1. Plug your camera into your computer. 
2. When the dialog for your camera appears, 

click the Cancel button.  
3. Launch iView MediaPro and open an ex-

isting catalog, or create a new catalog, into 
which to import the new images. Select Im-
port Items From Camera in the File menu. 

Download settings
4. Choose a Source: In the Source drop-down 

menu, select the camera or media card you 
want to import media from. 

5. Choose a Destination folder: Click the Desti-
nation folder icon. In the dialog, choose or cre-
ate a folder to place files that are downloaded 
from your camera.

Options
6. Place in: Download folder will place down-

loaded files in the destination folder.  Today’s 
folder will place downloaded files in a folder 
named after today’s date in the destination 
folder.  Original folder hierarchy will place 
downloaded files in copy of the folder direc-
tory hierarchy on the camera hard drive in the 
destination folder.

7. Rename: Enter a text string (such as the date 
or subject) in this field, and MediaPro will 
rename all downloaded files with sequential 
numbers following this string. Leave this field 
blank to maintain the existing filenames.  

8. Actions: Skip files with same name prevents 
you from writing over existing files with the 
same name. Set file creation date to capture 
date sets the image file’s creation date to 
match the date you took the picture (Capture 
Date). This is useful because some applications, 
as well as the operating system, cannot read 
the Capture Date. This way your media will be 
better organized on the desktop. Delete origi-
nals after downloading delete originals files 
off your camera’s media card after they have 
been downloaded to the destination folder.  

9. Annotate: Choose a metadata template from 
this drop-down menu to apply a group of pre-
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Import Items from Camera

Click the folder icon to choose a destination folder on 
the desktop where downloaded images will be placed.

Import Items from Camera: Options panel
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Import from a digital camera 
Mac OS X instructions
The OS X Image Capture application allows Mac 
users to automatically download images when 
a camera is attached to the computer. MediaPro 
has integrated this functionality to make catalog-
ing images during download from your camera as 
easy as possible.

1. Launch the Image Capture appli-
cation. It is located in the OS X 
Applications folder. 

2. Set Image Capture preferences:  
OS 10.2 - Open the Image Capture Prefer-
ences. Choose Other in Camera Preferences 
pop-up menu. Navigate to and choose iView 
MediaPro. Quit the Image Capture application. 
OS 10.3, 10.4 - In the Image Capture General 
panel, navigate to and choose iView MediaPro 
in the When a camera is connected, open pop-
up menu.

3. Plug your camera into your computer. From 
this point, whenever you plug a camera into 
your computer, Image Capture will launch 
MediaPro. To import images, select Import 
Items From Camera in the File menu. 

Download settings
4. Choose a Source: In the Source drop-down 

menu, select the camera or media card you 
want to import media from. 

5. Choose a Destination folder: Click the Desti-
nation folder icon. In the dialog, choose or cre-
ate a folder to place files that are downloaded 
from your camera.

defined annotations to all downloaded files. If 
there are no templates available, you can cre-
ate one by selecting New Metadata Template. 
Clicking the text button next to the menu will 
display the template content and some addi-
tional options for applying metadata.

10. Download: Once options have been set, click 
the Download button. MediaPro will import 
each image into the open catalog after it has 
been downloaded from the camera to the 
destination folder you defined. After import 
is complete, dismount the camera from the 
desktop (eject), then you can safely unplug your 
camera.

B. Without Picture Transfer Protocol 
These instructions also apply to digital media 
card readers that do not support PTP: 
1. Plug your camera into your computer, 

using a USB or serial connection. Or insert 
your digital media card (Compact Flash card, 
Memory Stick, etc.) into your card reader.

2. When the Device Action dialog appears, choose 
Copy pictures to a folder on my computer using 
Microsoft Scanner and Camera Wizard. 

3. Follow the directions of the Camera Wizard 
to locate an existing folder or to create a new 
folder for your pictures. On the last screen of 
the Wizard, choose Nothing. I’m finished work-
ing with these pictures.

4. Launch iView MediaPro and open an ex-
isting catalog, or create a new catalog,  into 
which to import the new images. Select Im-
port From Files/Folders in the File menu. Navi-
gate to and select the folder on your desktop 
where your images were placed with the 
Camera Wizard. 

5. Import images: iView MediaPro will import 
each image into an existing catalog, or a new 
catalog that you created.
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Mac OS X: Image Capture preferences dialog.
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Options
6. Place in: Download folder will place down-

loaded files in the destination folder.  Today’s 
folder will place downloaded files in a folder 
named after today’s date in the destination 
folder.  

7. Rename: Enter a text string (such as the date 
or subject) in this field, and MediaPro will 
rename all downloaded files with sequential 
numbers following this string. Leave this field 
blank to maintain the existing filenames.  

8. Actions: Skip files with same name prevents 
you from writing over existing files with the 
same name. Lock downloaded files turns on 
the desktop’s Lock status for all downloaded 
files.  Set file creation date to capture date sets 
the image file’s creation date to match the 
date you took the picture (Capture Date). This 
is useful because some applications, as well as 
the operating system, cannot read the Cap-
ture Date. This way your media will be better 
organized on the desktop. Delete originals after 
downloading delete originals files off your 
camera’s media card after they have been 
downloaded to the destination folder.  

9. Annotate: Choose a metadata template from 
this drop-down menu to apply a group of pre-
defined annotations to all downloaded files. If 
there are no templates available, you can cre-
ate one by selecting New Metadata Template. 
Clicking the text button next to the menu will 
display the template content and some addi-
tional options for applying metadata.

10. Download: Once options have been set, click 
the Download button. MediaPro will import 
each image into the open catalog after it has 
been downloaded from the camera to the 
destination folder you defined. After import 
is complete, dismount the camera from the 
desktop (eject), then you can safely unplug your 
camera.
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The Import from Camera dialog shows thumbnail 
previews of all images to be downloaded.

Annotate on import: 
Choose a metadata 
template from this 
drop-down menu to 
apply a group of pre-
defined annotations 
to all downloaded 
files. If there are no 
templates available, 
you can create one 
by selecting New 
Metadata Template. 

Click the folder icon to choose a destination folder on 
the desktop where downloaded images will be placed.
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Import from disk
Download settings
1. Open your catalog  or create a new one. 
2. Choose a Source disk: In the Source drop-

down menu, select the disk you want to 
import media from. MediaPro will import 
media from removable storage media such as 
CD or DVD.

3. Choose a Destination folder: Click the  
Destination folder icon. In the dialog, choose 
or create a folder for files that are downloaded 
from the disk.

4. Optional - Filter media types: To constrain 
an import to only image file formats, click on 
the Media Importers button and check only 
the Images box. This will prevent non-image 
files from being imported into the catalog. 
Imports can be filtered by any of eight differ-
ent media file type groups.

Options
5. Place in: Download folder will place down-

loaded files in the destination folder.  Today’s 
folder will place downloaded files in a folder 
named after today’s date in the destination 
folder.  Original folder hierarchy will place 
downloaded files in copy of the folder direc-
tory hierarchy on the web server in the desti-
nation folder.

6. Rename: Enter a text string (such as the date 
or subject) in this field, and MediaPro will 
rename all downloaded files with sequential 
numbers following this string. Leave this field 
blank to maintain the existing filenames.  

7. Actions: Skip files with same name prevents 
you from writing over existing files with the 
same name. Lock downloaded files turns on the 
desktop’s Lock status for all downloaded files.  
Delete originals after downloading move origi-
nals files to the recycle bin (trash) after they 
have been downloaded to the destination 
folder. This option will only work on rewritable 
storage media. 

8. Annotate: Choose a metadata template from 

this drop-down menu to apply a group of pre-
defined annotations to all downloaded files. If 
there are no templates available, you can cre-
ate one by selecting New Metadata Template. 
Clicking the text button next to the menu will 
display the template content and some addi-
tional options for applying metadata.

9. Download: Click the Download button and 
MediaPro will download all files from the disk, 
and store it in the destination you defined. 

Import Items from Disk: Example of downloading 
media from a CD-ROM. To constrain this import to only 
image file formats, click on the Media Importers button 
and check only the Images box. This will prevent non-
image media files from being imported into the catalog.
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Import Items from Disk: Options panel.
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Import from the Internet
Download settings
1. Open your catalog  or create a new one. 
2. Choose a Destination folder: Click the Des-

tination folder icon. In the dialog, choose or 
create a folder for files that are downloaded 
from the Internet.

3. Enter URL: Enter a web address in the text 
field at the top of the dialog. It must be a com-
pletely formed URL, such as: 
http://www.photo.com/img1.jpg

4. cURL syntax: MediaPro now support cURL 
commands for downloading files from the 
Internet. cURL is a special syntax for transfer-
ring files online (see example figure right).  To 
learn more about cURL, see the official site at:  
http://curl.haxx.se/

Options
5. Place in: Download folder will place down-

loaded files in the destination folder.  Today’s 
folder will place downloaded files in a folder 
named after today’s date in the destination 
folder.  Original folder hierarchy will place 
downloaded files in copy of the folder direc-
tory hierarchy on the web server in the desti-
nation folder.

6. Rename: Enter a text string (such as the date 
or subject) in this field, and MediaPro will 
rename all downloaded files with sequential 
numbers following this string. Leave this field 
blank to maintain the existing filenames.  

7. Actions: Skip files with same name prevents 
you from writing over existing files with the 
same name. Lock downloaded files turns on the 
desktop’s Lock status for all downloaded files.   

8. Annotate: Choose a metadata template from 
this drop-down menu to apply a group of pre-
defined annotations to all downloaded files. If 
there are no templates available, you can cre-
ate one by selecting New Metadata Template. 
Clicking the text button next to the menu will 
display the template content and some addi-
tional options for applying metadata.

9. Download: Click the Download button and 

MediaPro will download all files from the 
Internet, and store it in the destination you 
defined. MediaPro will also store the file’s web 
address in the Source URL annotation field.
Drag-and-drop option: You can also drag-and-

drop files from a web browser onto your catalog. 
This will launch the Download from URL dialog.
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Import from URL: Example of using cURL syntax to 
download a range of sequentially numbered files. 

Import from URL: Options panel

Place in: Choose Original folder hierarchy to download 
items to folders matching the web directory structure.
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Import with folder watching
MediaPro offers advanced folder watching to 
monitor all folders on a hard drive and local net-
work which contain cataloged media. When new 
media appears in a watched folder, it can be man-
ually or automatically imported to the catalog.

This is useful for a workflow in which:
• Images are being batch scanned and saved to 
a particular folder.

• A folder action is automatically downloading 
images off other computers or the Internet.

• Several users are contributing images to a 
shared network folder.

To turn on folder watching
1. Show Organize Panel by clicking the Orga-

nize toolbar button, or choose Window › 
Display › Organize Panel. This will reveal the 
Catalog Folders panel (see figure above). 

2. To enable folder watching, select an option 
from the catalog Folder Watching menu 
— either Update Folders: Every minute or Every 
5 minutes. 

3. Update folder: MediaPro will alert you when 
new images have been added to any folder 
by showing by a blue arrow on the folder icon. 
To import these new images directly to your 
catalog, select Update Folder Now from the 
individual folder’s drop-down menu.

4. Auto-update takes folder watching to the next 
level by automatically importing from selected 
folders when new images are added. To enable 
this feature, select Switch Auto-Update On in the 
menu of the individual folder that you want to 
be auto-updated. When new images are added 
to that folder or any sub-folder, MediaPro will 
automatically import those images into to your 
catalog. New images will be added to the end 
of the catalog. Auto-update folders are shown 
in green. Select Switch Auto-Update Off to turn 
off the auto-update feature, but maintain folder 
watching.

5. To turn off catalog-wide folder watching, 
select Never from the catalog Folder Watching 
menu. 
For more information, see page 83.
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Folder Watching menu

Green folders 
indicate auto-
update is on.

Blue arrows 
indicate 
that new, 
uncataloged 
images are 
in this folder. 
Select Update 
Folder Now to 
import these 
new items.

To expand  
all folders, 
Alt+Click (Mac: 
Option+Click) 
on the volume 
arrow.

Green indicates Folder Watching is on

Catalog Folders: Click the Organize toolbar button to show/hide the Catalog Folders panel (Window menu).

Individual folder menu : Reveal this 
menu by right-clicking (Mac: Option-
Clicking on the folder name.

Click the dot next to any folder to 
show only items in that folder in the 
media viewing area.
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Catalog information 
The Catalog Info dialog (File menu) contains infor-
mation about your catalog, as well as giving you a 
place to make comments about the catalog. The 
Comments field can be exported with HTML web 
galleries.

Protecting catalogs 
Once you have created a catalog, you might want 
to prevent others from viewing or accessing it. To 
set password protection for a catalog:
1.  Select Catalog Info from the File menu.
2.  Click the Set Password button. This button is 

only available if you have saved your catalog.
3.  Type the password. Then save the catalog. 
4.  When opening the catalog in the future, you 

will be asked to provide the password before 
you can view the catalog’s contents. MediaPro 
does not provide a way to recover catalog 
passwords. 

5.  To remove password protection, click the Set 
Password button and delete the password in 
the field. Then save your catalog, and pass-
word protection will be removed. 
MediaPro catalogs does not use strong encryp-

tion for password protection. For additional levels 
of security, try these options below.

Other options for protecting catalogs
Set read-only attribute (Windows): On the 

Finding catalogs
The Catalog Finder lets you to quickly locate and 
preview all iView catalogs on a storage volume 
(hard drive, CD, DVD, etc.).  This function is located 
in the Open Recent sub-menu of the File menu. 

1.  Select a storage volume from the pop-up 
menu, and MediaPro will locate all catalogs on 
that volume. 

2. Click the Find button to refresh the search. 
3. Click a catalog name in the search results list 

to preview the found catalog. 
4. Click Open to launch the catalog.

Catalog Finder:  Locate and preview catalogs. 
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Catalog Info dialog (File menu).
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desktop, select your catalog file and select Prop-
erties in the File menu. In the dialog, check the 
box Read-only under the Attributes section. This 
will prevent the file being altered. In the Advanced 
Attributes section, select Encrypt contents to secure 
data to increase protection.

You can also increase your catalog file’s security 
by setting user permissions for the catalog in the 
Security panel of this dialog. This would prevent 
other users from opening the catalog.

Set file lock properties (Mac): On the desktop, 
select your catalog file and select Get Info in the 
File menu. In the dialog, check the box Locked. This 
will prevent the file being altered.

While this option doesn’t prevent you or oth-
ers from altering catalogs (all you have to do is 
uncheck the box to unlock the catalog), it can serve 
as a useful reminder to prevent saving over a cata-
log that you do not want changed.

You can also increase security by setting user 
permissions for the catalog in the Ownership & 
Permissions section of this dialog. This would pre-
vent other users from opening the catalog.
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Set read-only attribute in the File Properties dialog. Set file lock status in the File Info dialog.

You can also increase security by setting user 
permissions for the catalog in the Ownership & 
Permissions section of this dialog. This would prevent 
other users from opening the catalog.

Encryption: Keep your catalogs and media on 
an encrypted disk image, such as one made by 
PGPdisk, which is available on both platforms.
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